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Introduzione  
 

Il CAMSIZER ® è uno strumento compatto da laboratorio costruito dalla Retsch Technology, una 
compagnia commerciale tedesca leader in tutto il mondo per la competenza acquisita nella produzione di 
strumenti destinati alla preparazione di campioni da laboratorio (vedi anche il sito web http://www.retsch-
technology.com). La Retsch, che ha sede a Haan (una cittadina tedesca situata tra Dusseldorf e Colonia), 
sviluppa e vende sistemi di misura ottici per la caratterizzazione delle particelle con la collaborazione 
dell’azienda tedesca Jenoptik (con sede in Germania) e della multinazionale Horiba (che invece ha sedi 
sparse in tutto il mondo).  

Il CAMSIZER misura e analizza simultaneamente le dimensioni e le forme di particelle solide 
incoerenti in un intervallo compreso tra 30 µm e 30 mm, ed è uno strumento molto diffuso in campo 
industriale per il controllo di qualità di materiali più disparati (dalla pasta alimentare, ai materiali sciolti edili, 
ai farmaci ecc.).  

La Sezione di Catania dell’Istituto Nazionale di Geofisica e Vulcanologia ha comprato il CAMSIZER 
alla fine del 2005. Questo è stato installato nel Laboratorio di Sedimentologia con l’obiettivo principale di 
misurare le dimensioni e la distribuzione di taglia delle particelle vulcaniche nell’ambito del monitoraggio 
vulcanico della Sicilia orientale. In quest’area, infatti, sono presenti due tra i vulcani più attivi al mondo, 
ovvero l’Etna e lo Stromboli. Il primo è caratterizzato da un’attività esplosiva molto frequente, che 
comprende sia eventi parossistici episodici (dalla durata di decine di minuti fino a pochi giorni) che periodi 
con attività stromboliana o parossistica prolungata (giorni-settimane) [Alparone et al., 2003; 2007; 
Andronico et al., 2005]. A Stromboli, invece, fin da epoca romana l’attività normale si manifesta con 
esplosioni stromboliane quasi continue, la cui frequenza oraria è estremamente variabile e negli ultimi anni è 
stata da 3-4 fino a 30 esplosioni l’ora [vedi rapporti pubblicati sul sito web della sezione di Catania 
www.ct.ingv.it; ad esempio, Andronico et al., 2008; Cristaldi, 2008]. Durante la vita eruttiva di questi 
vulcani, pertanto, è abbastanza comune la formazione di quantità abbondanti di prodotti dell’attività 
esplosiva, che vengono dispersi in atmosfera ricadendo sui fianchi vulcanici e sulle aree abitate. Tali prodotti 
sono detti piroclastiti o tefra e si possono suddividere, sulla base delle loro dimensioni, in tre categorie 
principali: ceneri (particelle con dimensioni inferiori ai 2 mm), lapilli (tra 2 e 64 mm) e blocchi o bombe 
(>64 mm).  

Tra le attività di routine intraprese durante il monitoraggio dei prodotti dell’attività esplosiva è 
prevista, appunto, anche la caratterizzazione granulometrica dei tefra emessi. L’uso del CAMSIZER sui 
prodotti vulcanici con dimensioni comprese nell’intervallo di misura dello strumento, vale a dire da ceneri a 
lapilli fini, permette di ridurre notevolmente i tempi necessari per l’acquisizione dei dati granulometrici e di 
migliorare la qualità stessa dei dati ottenuti. 

In questo rapporto sono descritti i principi di funzionamento del CAMSIZER e le procedure da seguire 
per misurare le particelle vulcaniche (dette anche clasti). L’analisi delle forme delle particelle misurate, 
sebbene tali misure siano eseguite simultaneamente dal CAMSIZER senza particolari accorgimenti, non è 
oggetto del presente rapporto. L’argomento “misura delle forme e dei relativi parametri” su particelle come 
quelle vulcaniche, infatti, è molto complesso e pone dei problemi di affidabilità che meritano di essere 
studiati e approfonditi a parte.  

Il CAMISZER (fig. 1) è costituito da un corpo centrale provvisto di un imbuto (funnel) in cui viene 
posto il campione di materiale vulcanico da misurare. È preferibile essiccare preventivamente il campione in 
stufa per eliminare l’umidità presente sia all’interno dei clasti che tra un clasto e l’altro, che potrebbe creare 
dei fenomeni di aggregazione delle particelle falsando così i risultati della misura. Dall’imbuto il materiale 
cade su un piatto vibrante (feeder) che fa scorrere le singole particelle vulcaniche di cui è costituito il 
campione verso la camera di misura (fig. 1).  

La quantità di campione da immettere nell’apparecchiatura non è definibile, in quanto 1) maggiore è il 
numero di clasti immessi, più accurata sarà la misura dal punto di vista statistico, e 2) a parità di quantità di 
peso immessa, i campioni più fini saranno costituiti da un numero di particelle più alto rispetto ai campioni 
più grossolani e quindi le misure risultanti saranno più accurate. È bene infine ricordare che la quantità 
massima da immettere nell’apparecchiatura deve essere tale da non fuoriuscire dal feeder del CAMSIZER e 
che maggiore è la quantità del campione immesso, maggiore sarà il tempo necessario a eseguire la misura. 
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Figura 1.  Strumento CAMSIZER e principali parti costituenti. La freccia mostra il dettaglio del campione 
che dal feeder cade all’interno della camera di misura. 

 
 

Mentre cadono all’interno della camera di misura, i clasti vengono illuminati da una sorgente luminosa 
e le loro immagini acquisite da due telecamere digitali, una per i clasti di dimensioni maggiori (CCD-Basic) 
e l’altra per quelli più piccoli (CCD-Zoom) (fig. 2). L’intervallo di misura della CCD-Basic va da circa 400 
µm a 30 mm, riuscendo quindi a coprire un ampio spettro dimensionale di particelle ma non le più fini. Per 
questo tipo di misure entra in gioco la CCD-Zoom, che è capace di misurare le particelle più piccole 
nell’intervallo compreso tra 30 µm e 3 mm. 

 
 
 
 
                               
 
 
 
 
 
 
 
 
 

 
Figura 2.  a) Foto e b) schema delle due telecamere digitali interne che riprendono le immagini di particelle 

in caduta nella camera di misura. 
 

 
 
Le immagini registrate dalla telecamera vengono elaborate in tempo reale da un software installato sul 

computer e collegato allo strumento. I risultati parziali della misura possono essere visualizzati durante 
l’esecuzione della misura tramite un grafico cumulativo che si aggiorna continuamente. I risultati finali 
invece possono essere rappresentati sia mediante una curva cumulativa che attraverso altri tipi di grafici 
(istogrammi e gaussiane). Infine è possibile visualizzare delle tabelle e dei report riassuntivi dei valori e dei 
parametri misurati sia delle dimensioni che delle forme delle particelle costituenti il campione analizzato.  

Nei prossimi paragrafi saranno descritte le prime prove effettuate con il CAMSIZER. 
Successivamente saranno riportate delle nozioni sintetiche sull’analisi d’immagine e illustrati i modelli più 
comuni utilizzati per definire le dimensioni delle particelle, i parametri che descrivono dimensioni e forme 
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delle particelle, e le diverse modalità di rappresentazione delle misure effettuate insieme ai differenti tipi di 
tabelle e report. La parte principale di questo rapporto è dedicata tuttavia alla descrizione delle operazioni 
necessarie per eseguire una misura col CAMSIZER, a partire dalla creazione di un task file e alla 
impostazione ottimale dei parametri utilizzati all’interno del task file, per finire alla pulizia dello strumento e 
alle operazioni da compiere a fine misura.  

 
 
1. Installazione e prime prove di analisi al CAMSIZER  
 

Nel corso del 2006 il CAMSIZER era stato testato su una serie di campioni di tefra caratterizzati da 
diverse granulometrie (da lapilli a ceneri) provenienti dai vulcani italiani Etna, Stromboli, Vesuvio e dal 
Cotopaxi (Ecuador) e su campioni non vulcanici (es: sale grosso da cucina). Queste prove erano state fatte 
sia per sperimentare lo strumento sui vari tipi di materiali utilizzati che per confrontare i risultati ottenuti dal 
CAMSIZER con le misure eseguite attraverso il metodo classico dell’analisi granulometrica con l’utilizzo di 
setacci.  

A fine 2007 è stato aggiornato il software (CAMSIZER 4.2.1) che fa interagire il pc con il 
CAMSIZER e con esso sono cambiati in maniera significativa sia i parametri di input che il menu del 
software. Il nuovo software è stato ottenuto nel corso di un meeting di aggiornamento tenutosi a Haan a 
febbraio 2008, durante il quale sono state presentate le principali novità della nuova versione rispetto a quella 
vecchia e spiegato il loro funzionamento. Dopo aver installato il nuovo software, tra marzo e aprile 2008, è 
stata ripetuta la taratura dello strumento attraverso l’analisi granulometrica di nuovi campioni. In particolare 
sono stati selezionati e/o preparati artificialmente 10 diversi campioni di tefra dell’Etna mediante l’ausilio 
dei setacci. I campioni utilizzati per l’impostazione dei parametri del software sono caratterizzati da 
differenti granulometrie (da fini a grossolani) ed eterogeneità, come elencati in Appendice A. In questo modo 
abbiamo cercato di rappresentare nella maniera più completa tutti i campioni che un vulcano come l’Etna 
può produrre e disperdere nelle varie situazioni, ovvero lungo l’asse di dispersione o lateralmente all’area di 
ricaduta, e in aree da prossimali a distali. In generale, infatti, maggiore sarà la distanza di ricaduta dei tefra 
emessi, minori saranno le loro dimensioni, e maggiore sarà la loro omogeneità dimensionale detta anche 
unimodalità. 

Le prove effettuate hanno permesso di scegliere i parametri ottimali da utilizzare a seconda della 
granulometria dei materiali da misurare. Questi parametri sono stati inseriti in Appendice A insieme al nome 
del file e alla tipologia del campione (cioè le caratteristiche granulometriche) adatto a quel set di parametri.  
 
 
2. Descrizione delle caratteristiche del software 
 

Il software che gestisce le misure del CAMSIZER si basa sulla tecnica dell’analisi di immagine e 
permette di calcolare, oltre alla caratteristiche dimensionali e di forma delle particelle, tutte le distribuzioni di 
parametri standard, quali volume, area e numero di particelle. 

 
Un processo di misura è suddiviso in 3 fasi: 
 
1) Definizione di un task file di misura 
2) Misura delle particelle 
3) Analisi e visualizzazione dei risultati 
 
1) La definizione del task file di misura è molto importante in quanto esso contiene tutti i parametri del 

software da impostare che servono per le fasi successive, ovvero la misura delle particelle, l’analisi e la 
visualizzazione dei risultati. All’interno del task file vengono impostati anche gli intervalli delle classi 
granulometriche (size class files) che si vogliono utilizzare per la misura (e, se si desidera, tutti i parametri di 
forma da misurare). Senza aver prima definito un task file e almeno un size class file all’interno di esso non è 
possibile cominciare una misura.  

2) La dimensione delle particelle può essere calcolata applicando diversi modelli matematici, e si 
avranno quindi diversi risultati in base al tipo di modello.  
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3) I risultati ottenuti vengono rappresentati sia graficamente che in tabelle ed espressi in frazioni 
dimensionali, distribuzioni cumulative e di frequenza. Tali distribuzioni possono essere espresse in base a i) 
volume (Q3), ii) area (Q2) e iii) numero di particelle (Q0). 
 
2.1. Cenni sull’analisi di immagine  

L'analisi di immagine è una tecnica molto versatile che trova applicazione in svariate discipline e 
consiste nella manipolazione e analisi di informazioni rappresentate come immagini.  

Partendo da un’immagine simile a quella elaborata dal nostro sistema visivo, mediante l’analisi di 
immagine è possibile calcolare diversi parametri come forma, taglia, numero e densità ottica di ogni parte 
identificabile dell’immagine di partenza. 

Per poter fare l’analisi di immagine occorre una strumentazione di base, in genere costituita da un 
computer provvisto di un dispositivo di ingresso capace di raccogliere immagini (generalmente una 
telecamera) e collegato a una scheda che traduce queste immagini in forma digitale, cioè in forma leggibile, 
interpretabile e visualizzabile dal computer (fig. 3). 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 

Figura 3.  Schema della strumentazione necessaria per l’analisi di immagine (da www.distam.unimi.it). 
 

 
L'hardware di acquisizione 

Le immagini possono essere acquisite con differenti dispositivi, quali scanner, fotocamere, 
videocamere. Oggi sono quasi esclusivamente usate le telecamere al CCD (Charge-Coupled Devices), 
poiché presentano numerosi vantaggi rispetto alle altre: sono molto più piccole e più leggere e i CCD offrono 
una risposta alla lunghezza d'onda della luce più simile a quella dell'occhio umano. Inoltre il segnale da esse 
generato è molto più pulito, cioè è quasi esente da rumori di fondo o altri disturbi che sono invece 
caratteristici delle telecamere tradizionali. 
 
Acquisizione dell’immagine 

L'immagine è acquisita in forma digitalizzata e in differenti formati di interscambio: gli elementi 
caratteristici sono la risoluzione di acquisizione o visualizzazione (espressa in pixel per inch) e il tipo (B/N, 
scala di 16 o 256 grigi o colori, milioni di colori), che identifica la quantità di informazioni associata a ogni 
pixel (ad esempio, 8 bit per pixel corrispondono a 256 colori). Il pixel o unità base è identificato all’interno 
di un'immagine dalla sua posizione relativa (x,y) e dalle sue caratteristiche di colore/intensità espresse come 
RGB o Gray Level. 

Le immagini a colori, in particolare, sono rappresentate mediante i colori primari Red (rosso), Green 
(verde) e Blue (blu), dette coordinate cromatiche RGB. Nel formato convenzionale RGB, pertanto, 
un'immagine è rappresentata, in ogni pixel considerato, come l'intensità di questi tre colori base. Quando tutti 
i tre colori valgono zero, il colore dell'oggetto è nero; quando tutti i tre colori hanno il valore massimo, il 
colore dell'oggetto è bianco. Livelli uguali di R, G e B generano il grigio e quindi l’immagine viene definita 
dal Gray Level. 
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Tipi di misure 
La struttura morfologica di un'immagine si riferisce alle strutture geometriche e la sua analisi include 

misure di dimensioni, distanza, forma, caratteristiche di struttura e descrizione della distribuzione delle 
particelle. 

In termini più generali, le misure derivabili dall'applicazione dell'analisi dell'immagine sono di due 
tipi: a) misure relative a proprietà specifiche e b) misure relative a parametri globali.  

a) Esempi di misure relative a proprietà specifiche sono i parametri dimensionali di un oggetto (area, 
lunghezza, larghezza, perimetro, diametro equivalente) o di forma (indice di forma, rapporto di aspetto, 
indici di convessità e solidità), o ancora di chroma o intensità (valori R,G,B o di Gray Level).  

b) Esempi di misure globali dell'immagine sono la determinazione di frazioni di superficie, la 
numerazione degli oggetti, la determinazione di lunghezza e curvatura delle linee e di vari tipi di parametri di 
gradiente o di orientamento. 

I sistemi di analisi di immagine acquisiscono un’immagine bidimensionale da una particella 
tridimensionale dalla quale è possibile calcolare diversi parametri di forma e dimensione. Descrivere una 
particella tridimensionale è un’operazione abbastanza complessa. Per semplicità si usa descrivere la 
dimensione di una particella mediante un solo numero.  

Uno dei parametri più importanti è il diametro equivalente, che è il diametro di un cerchio avente la 
stessa area dell’immagine bidimensionale della particella (fig. 4). Questo valore è un singolo numero 
proporzionale alla particella stessa, oggettivo e ripetibile. 
 
 
 

 
 
 
 

 
 
 

Figura 4.  Schema illustrante i passaggi nell’acquisizione dell’immagine di una particella 3D da immagine 
bidimensionale a cerchio con la stessa area di proiezione. 

 
 

Naturalmente, per avere la piena attendibilità statistica è necessario misurare un certo numero di 
particelle rappresentative del campione e di ognuna calcolare il parametro relativo. Ad esempio, uno dei 
parametri più rappresentativi delle misure effettuate è la media di tutti i diametri equivalenti.  

Una volta creata una distribuzione di oggetti possono essere calcolati facilmente tutti i diversi 
parametri statistici quali: media, mediana, moda, deviazione standard, percentili ecc. (fig. 5).  

 

 
Figura 5.  Esempi di parametri statistici. 
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Misurare soltanto la dimensione di una particella potrebbe essere non sufficiente a rilevare differenze 
significative tra diversi campioni. La quantificazione della forma di una particella 3D è ancora più difficile 
della stima delle sue dimensioni perchè esistono infiniti modi di descrivere la forma di una particella 
complessa. Per esempio, considerando 3 forme diverse (fig. 6) aventi la stessa area, quando le immagini 
relative alle 3 diverse particelle vengono convertite in diametro equivalente, danno lo stesso risultato. Ciò 
significa che forme diverse potrebbero essere considerate identiche e quindi rappresentate dallo stesso 
parametro di forma solo perché hanno la stessa proiezione dell’area bidimensionale o volumi sferici 
equivalenti uguali. 

 
 

 
 

Figura 6.  Forme diverse aventi la stessa area. 
 
 

 
2.2. Modelli utilizzati dal software per definire le dimensioni delle particelle 

Dal punto di vista teorico, per definire la dimensione (x) di una particella, la versione base del 
software utilizza diversi modelli 3D delle particelle: i) modello sferico, ii) modello cubico, e iii) modello del 
parallelepipedo. 

i) Quando viene usato il modello sferico, x è uguale al diametro equivalente del cerchio avente la 
stessa area di proiezione della particella. 

ii) Nel caso del modello cubico, x corrisponde alla lunghezza degli spigoli del cubo avente lo stesso 
volume della sfera col diametro equivalente. 

iii) Nel modello del parallelepipedo, infine, x corrisponde alla lunghezza dello spigolo del 
parallelepipedo avente lo stesso volume della sfera col diametro equivalente. 

Nella versione più recente del software (CAMSIZER 4.2.1), inoltre, sono previsti 7 modelli 
matematici, in base ai quali il calcolo della dimensione x viene effettuato relativamente a diversi parametri:  

xc_min, x_area, xFe_min, xFe_max, xMa_min, xMa_rec, x_length.  
Ogni modello permette quindi di misurare proprietà diverse di una particella a cui corrispondono 

diverse distribuzioni cumulative del volume di particelle (Q3-distribution).  
Generalmente, è preferibile impostare solo i 3 modelli più utilizzati, ovvero x_area, xc_min e 

xFe_max (fig. 8, 9 e 10).  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 7.  Parametri geometrici di una particella. 
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- xc_min (larghezza) – Corda minima: si riferisce alla lunghezza minima della particella nella direzione di 
misura. Il software determina tale valore in 64 direzioni (fig. 7 e 8). 
 

 
 
 
 
 

 
 
 
 
 

Figura 8.  Parametro xc_min (Corda minima) corrispondente alla larghezza della particella. 
 
 
x_area – diametro del cerchio avente la stessa area di proiezione della particella (fig. 9). 
 
 
 

 
 
 
 
 
 
 
 

 
Figura 9.  Parametro x_area corrispondente al diametro del cerchio equivalente della particella. 

 
 
- xFe – Diametro di Feret: Distanza tra due tangenti alla particella poste a 90° dalla direzione di misura. Il 
programma calcola tale valore per 64 direzioni. I parametri xFe_max e xFe_min sono riferiti rispettivamente 
al massimo e al minimo valore del diametro di Feret ottenuto per tutte le direzioni (fig. 7 e 9). 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 10.  Parametro xFe_max - Diametro di Feret. 

 
 
 
- xMa – Diametro di Martin: lunghezza della linea bisecante l’area della particella nella direzione di misura. 
Il software determina tale valore per 64 direzioni. 
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Figura 11.  Parametro xMa - Diametro di Martin che divide il profilo in 2 aree uguali. 
 
 
 

La scelta del modello da utilizzare durante le misure dipende dal tipo di applicazione, ad esempio il 
modello xc_min è considerato un parametro significativo per comparare i risultati del CAMSIZER con 
quelli del metodo della setacciatura, mentre xFe_max è spesso usato per i campioni estrusi (cioè allungati). 
La figura 12 mostra le differenze delle curve cumulative dello stesso campione (A) misurato con modelli 
diversi (xc_min, x_area e xFe_max). 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 12.  Curve cumulative relative a 3 misure effettuate sullo stesso campione A ma con 3 diversi 
modelli delle particelle. 

 
 
2.3. Modelli per calcolare volume e area delle particelle. 

I valori di volume e area delle particelle, misurati e calcolati dal software del CAMSIZER, si basano 
sul modello di una sfera per le misure x_area (fig. 13) e di un ellissoide per le misure con xc_min, xFe_min, 
xMa_min, e xFe_max (fig. 14).  

Per determinare volume e superficie, in particolare, possono essere utilizzati i seguenti modelli di 
ellissoidi: 

-ellissoide (l,b,b) con assi xFe_max, xc_min, xc_min 

xMa 
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-ellissoide (l,l,b) con assi xFe_max, xFe_max, xc_min 
-ellissoide (l,b,(l+b)/2) con assi xFe_max, xc_min, (xFe_max+xc_min)/2 
 
C’è una buona correlazione tra percentuale in peso (m) e volume (V) quando la densità (ρ) della 

particella è omogenea (ρ=m/V ovvero la distribuzione di massa è circa uguale alla distribuzione di volume). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
Figura 13.  Schema indicante il metodo per calcolare il volume di una particella , basato sul modello di una 

sfera, nel caso di misure con il parametro x_area. 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 14.  Schema indicante il metodo per calcolare il volume di una particella , basato sul modello di un 
ellissoide, nel caso di misure con i parametri xc_min, xFe_min, xMa_min, e xFe_max. 
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2.4. Parametri dimensionali e di forma 
Come abbiamo visto nel paragrafo 2.2, la dimensione x di una particella può essere definita attraverso 

i seguenti parametri dimensionali:  
x_area, xc_min, xFe_min, xFe_max, x_length, x_stretch, xMa_min, xMa_rec.  
 
Il software del CAMSIZER, inoltre, può determinare anche i seguenti parametri basati su a) volume, 

b) area, c) numero di particelle e d) forma: 
 
a) parametri basati sul volume 
 

p3(x1,x2) - proporzione in volume di particelle nell’intervallo (x1, x2) rispetto al volume totale: 
 

p3 (x1, x2) = Q3 (x2) – Q3 (x1) 
 

Q3(x) - distribuzione cumulative basata sul volume (“materiale passante” in analogia con la 
setacciatura): proporzione in volume di particelle più piccole della dimensione x, rispetto al volume totale 

1-Q3(x)  - distribuzione cumulative del residuo 1-Q3(x), basata sul volume (“materiale trattenuto” in 
analogia con la setacciatura) 

q3(x) - densità di distribuzione: derivata prima di Q3 (x) 
 

q3 (x) = dQ3 (x) 
 dx 

 
 
b) parametri basati sull’area 
 

p2(x1,x2) - proporzione in superficie di particelle nell’intervallo (x1, x2) rispetto all’area 
totale: 

p2 (x1, x2) = Q2 (x2) – Q2 (x1) 
 

Q2(x) - distribuzione cumulative Q2(x), basata sull’area: proporzione in superficie di particelle più 
piccole della dimensione x, rispetto all’area totale 

1-Q2(x)  - distribuzione cumulative del residuo 1-Q2(x), basata sull’area 
q2(x) - densità di distribuzione q2(x), basata sull’area 
 

q2(x)= dQ2 (x) 
 dx 

 
c) parametri basati sul numero di particelle 
 

p0(x1,x2) – numero di particelle nell’intervallo (x1, x2) rispetto al numero totale di particelle: 
p0 (x1, x2) = Q0 (x2) – Q0 (x1) 

 
Q0(x) - numero di particelle più piccole della dimensione x, rispetto al numero totale di particelle 
1-Q0(x)  - distribuzione cumulative del residuo basata sul numero di particelle 
q0(x) - densità di distribuzione: derivata prima di Q0 (x) 
 

q0(x)= dQ0 (x) 
 dx 

 
Dai vari parametri sopra descritti si possono ricavare le seguenti caratteristiche: 

 
x(Q3) - dimensione x in corrispondenza della quale Q3 assume un valore specifico 
U3 - nonuniformity, basata sul volume: X60/X10 dove  X60= valore di x in cui Q3=60% 

 X10= valore di x in cui Q3=10% 
x(Q0) - dimensione x in corrispondenza della quale Q0 assume un valore specifico  



 15 

U0 - nonuniformity, basato sul numero delle particelle 
x(Q2) - dimensione x in corrispondenza della quale Q2 assume un valore specifico  
U2 - nonuniformity, basata sull’area 
Sv - area di superficie specifica, basata sul volume: 

superficie di tutte le particelle/ volume di tutte le particelle 
Sm - area di superficie specifica, basata sulla massa: 

superficie di tutte le particelle/ massa di tutte le particelle 
rD - densità relative: massa del campione diviso il volume calcolato dal CAMSIZER 
CV - coefficiente di variazione: 50 (X84-X16/X50) 
MA - media = X50 

 
d) parametri di forma 
 

xFe  - Diametro di Feret 
xMa  - Diametro di Martin 
xc  - Corda 
SPHT - Sfericità= 4πA/U2 A=area; U=circonferenza 
xmean - Diametro medio: determinato dal diametro equivalente di cerchi con la stessa area di 

proiezione, usando lo stesso metodo del diametro di Feret, il diametro di Martin e la corda massima e serve 
come valore di riferimento per tali parametri. 

PD - Numero di particelle ricavate. Misura dell’attendibilità statistica dei parametri di forma. 
Maggiore è PD, più attendibile è il valore di xFe, xMa e SPHT. 

xFe_min - minimo degli xFe in tutte le direzioni 
xMa_min - minimo degli xMa in tutte le direzioni  
xc_min -  - minimo degli xc in tutte le direzioni 
xFe_max - Massimo degli xFe in tutte le direzioni 
xMa_max - Massimo degli xMa in tutte le direzioni 
xc_max - Massimo degli xc in tutte le direzioni 
b/l_rec : - min(Xc/XFe) 
b/l  - min Xc / max XFe 
Sigma(v) - deviazione standard  
NSP  - proporzione di particelle non sferiche: proporzione di particelle in cui SPHT è 

minore di una data soglia, basata sul numero di particelle 
Q0(SPHT) - proporzione di particelle con sfericità minore o uguale alla soglia SPHT, basata sul 

numero di particelle  
 
 

3. Schema delle operazioni per eseguire una misura 
 

In questo paragrafo vengono descritte le operazioni base da eseguire prima, durante e dopo una misura 
di particelle vulcaniche col CAMSIZER.  

1) Accendere il CAMSIZER e il computer a esso collegato; per entrambe le strumentazioni i tasti di 
accensione sono posti nella parte posteriore. 

2) Aprire il software CAMSIZER cliccando sull’omonima icona posta sul desktop  
3) Definizione del task file. Esistono 3 modi per definire un task file. 
a) Creare un nuovo task file selezionando la voce New task file dal menù File. Questa funzione è utile 

per determinare automaticamente i parametri di controllo del feeder per un campione nuovo 
(paragrafo 3.1.1, fig. 15). 

b) Modificare un task file preesistente cliccando su File → Load task file → Edit. In questo caso si 
aprirà la finestra Measurement conditions nella quale si trovano i 12 sottomenù in cui è possibile 
impostare tutti i parametri disponibili per la successiva misura (paragrafo 3.1.2, fig. 16)  

c) Gli stessi parametri possono essere impostati direttamente dal menù Options → Measurement 
parameters oppure Options → Size classes. 

Dopo aver impostato o modificato i parametri scelti per la misura, si salva il task file usando la 
funzione Save task file.  
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4) A questo punto si può procedere con la fase di misura. Cliccare su Measure prima di inserire il 
campione. Questo passaggio è importantissimo, in quanto si abbassa automaticamente il funnel 
(all’altezza impostata in precedenza nel sottomenù Feeder and funnel parameters) per cui se 
avessimo già deposto il campione, questo si sarebbe frantumato.  

Si apre la finestra Start measurement in cui vanno inserite le caratteristiche del campione (ad esempio, 
tipo di materiale, nome del file da attribuire al campione ecc.). Cliccando su OK parte la misura.  
 

3.1. Creazione di un task file 
Tutti i parametri di analisi vengono determinati prima della misura vera e propria e vengono salvati nei 

cosiddetti task file (nome del file*.afg).  
Un task di misura contiene tutte le impostazioni del programma richieste per effettuare una misura e 

per visualizzare i risultati. 
 È consigliabile impostare diversi task file per i diversi materiali analizzati, cambiando così le 

caratteristiche delle particelle, le dimensioni, i parametri ottimali per il controllo del feeder ecc. 
I task file generati possono essere eventualmente protetti mediante l’introduzione di diversi livelli di 

password nel software. 
 
3.1.1. Creare un nuovo task file 

Cliccando su File → New task file si apre una finestra (fig. 15) in cui verranno visualizzate le 
seguenti voci: 

Task file, a lato del quale è presente il nome; 
Maximum size of the particles: inserire le dimensioni massime stimate delle particelle da misurare; 
Width of feeder: ampiezza in mm del feeder usato (60 mm per il feeder più grande e 15 mm per il 

feeder più piccolo); 
Use of a guidance sheet: marcare tale casella se viene usata una guida aggiuntiva utile per la 

misurazione delle particelle più fini; 
With guidance sheet: marcare tale casella se utilizziamo l’apposita guida aggiuntiva in dotazione per 

indirizzare meglio le particelle più fini (<1 mm); 
Vacuum: marcare tale casella se viene utilizzata l’aspirazione durante la misura (se viene attivata la 

leva nera posta nella parte posteriore dello strumento); 
A questo punto siamo pronti per inserire il campione nel funnel e muovere la barra di scorrimento 

presente nella finestra fino a quando la prima particella non cade nella camera di misura. Tale operazione 
serve a determinare la velocità iniziale di movimento del feeder; 

Cliccare su OK. La voce Start measurement diventa attiva; 
Cliccando su OK inizia una misura di prova dopo la quale può essere impostato il task file cliccando 

su Edit. A questo punto si apre la finestra Measurement conditions in cui possono essere impostati i 
parametri di misura. 
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Figura 15.  Finestra di dialogo che serve a creare un nuovo task file. 
 

 
3.1.2. Caricare o impostare un task file preesistente 

Cliccare su File → Load task file per aprire la relative finestra di dialogo (fig. 16).  
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 16.  Finestra di dialogo che serve a modificare un task file preesistente. 
 

 
 

Per selezionare un task file preesistente, scorrere tra i task files eventualmente disponibili nella voce 
Task file name e ciccare su OK. 

Per modificare un task file preesistente o crearne uno nuovo cliccare sul tasto Edit. In questo caso 
appare la finestra Measurement conditions e la wizard guiderà l’utente passo passo nel processo di editing 
del task file. 

Da questa finestra si aprono successivamente 2 finestre principali suddivise in sotto categorie. 
La prima finestra è Measurement conditions (fig. 17), mentre la seconda è Parameters for display. 
Inizialmente viene aperta la prima sottocategoria della prima finestra di controllo, mentre le altre 

sottocategorie vengono aperte cliccando sulla relative tabella oppure sul tasto Next del menu o Invio sulla 
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tastiera. L’ultima sottocategoria della relativa finestra di controllo (Save task file) viene bypassata e si passa 
direttamente alla prima sottocategoria della seconda finestra di controllo Parameters for display. Alla fine 
di questa finestra, ciccando sul tasto Next si ricomincia con la prima sottocategoria della finestra 
Measurement conditions.  

 
 

 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 17.  Finestra di dialogo Measurement conditions → Feeder and funnel parameters. 

 
 
 

Cliccando su OK si apre la finestra Save task file in cui viene salvato il task file cliccando su OK, 
mentre cliccando su Undo, vengono resettati tutti i cambiamenti effettuati nella finestra di controllo attiva.  

Le sottocategorie possono essere aperte anche cliccando sulle funzioni del menù (fig. 18): 
Options → Measurement parameters,  
Options → Size classes...,  
Options →Volume classes for Q(V)... and  
Options → Classes for shape characteristic.  
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Figura 18.  Funzione Options del Menù principale. 

 
 
 
3.2. Parametri del la finestra “Measurement conditions” 

La prima finestra Measurement conditions serve a impostare i parametri più importanti per la misura 
e contiene le seguenti sottocategorie (fig. 17): 

 
Feeder and funnel parameters 
Cameras (measurement parameters) 
Save images 
Settings 
Warnings 
Save task file 

 
3.2.1. Feeder and funnel parameters  

In questa sottocategoria si impostano i parametri relativi all’altezza del funnel e alla velocità del feeder 
prima, durante e dopo la misura (fig. 17). 

Funnel position si riferisce all’altezza dell’imbuto che deve essere circa 3 volte maggiore del valore 
della massima taglia granulometrica del campione da analizzare. Ad esempio, per particelle inferiori a 2 mm, 
la posizione del funnel di 3 mm va bene. 

Nella finestra Width of feeder viene inserito il valore minore dell’ampiezza del feeder. Per esempio, 
nel caso di un feeder 15/40 mm va inserito il valore 15. 

Marcare la casella With guidance sheet se viene usata una guida aggiuntiva utile per la misurazione 
delle particelle più fini. 

Marcare la casella Vacuum se viene utilizzata l’aspirazione durante la misura (se viene attivata la leva 
nera posta nella parte posteriore dello strumento). 

Il Fast forward si riferisce alla velocità del feeder prima che inizi la misura. Il feeder si muove con 
una velocità espressa in valori compresi tra 0 e 100%, e bisogna trovare il valore ottimale del Control Level 
for Fast Forward che dipende da vari fattori, ovvero a) dimensione delle particelle, b) tipo di feeder, c) peso 
del campione. 

 È consigliabile inserire il campione nel funnel, far partire manualmente il feeder, vedere come si 
muove il materiale, e regolare di conseguenza il valore. 

Lo Starting Level for Measurement si riferisce alla velocità del feeder durante la parte iniziale della 
misura, che viene successivamente regolata automaticamente dal computer in modo da mantenere costante la 
densità di target (Nominal covered area). Tale valore dovrebbe essere circa il 5% più basso del Control 
Level (5-10 volte in meno). 

L’obiettivo della misura è quello di far muovere il feeder in modo da far cadere qualche particella. 
Queste particelle iniziali vengono registrate, il PC ferma il feeder e otteniamo la cosiddetta background 
measurement. Per esempio, se abbiamo polveri nella finestra, queste vengono sottratte dalla misura e non 
vengono contate come particelle. 

Subito dopo parte la misura vera, il materiale si muove in relazione allo Starting Level, che viene poi 
regolato dal pc in modo da avere sempre la stessa densità di target. 
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Per trovare il valore ottimale di Starting Level for measurement basta effettuare una misura e 
controllare il valore “ur” che appare nella parte inferiore sinistra della finestra di misura a circa metà della 
misura stessa.  

Nella finestra di Fast Forward, la voce Include in measurement, if, si riferisce alle particelle 
registrate durante la misura di background. Se si vogliono includere tali particelle nella misura bisogna 
attivare tali finestre. A volte non è importante includere tali misure, perché si perde solo una piccola quantità 
di materiale, ma, nel caso di poco campione o di misure di densità conviene attivarle. 

Il valore percentuale da inserire dipende dalle dimensioni dei campioni e dalla densità di target. Per 
esempio, per campioni fini con una densità di target pari a 0,5, un valore di 5 è troppo alto perché indica 
molte aree nere e particelle grossolane e la misura finale è sbagliata perché le aree nere sono contate come 
particelle grandi. Per tale valore di densità di target è più giusto un valore percentuale di 1. Se si hanno 
campioni più grossolani va aumentato questo valore. 

Il Max Duration for Fast Forward è un valore che esprime i secondi dopo i quali il feeder si ferma 
se non trova particelle nel feeder, interrompendo la misura. Il valore di 45 secondi è un valore ottimale per 
tutti i tipi di campioni. 

Il Max control level è la velocità del feeder alla fine della misura, che si riferisce alla rimozione del 
materiale residuo e quindi alla pulizia del feeder. Tale valore deve essere circa il 20% più alto del valore di 
Starting level, in modo da permettere la pulizia del feeder alla fine della misura, ma di evitare altresì la 
caduta troppo violenta delle particelle. Per esempio, per uno Starting level=75 useremo Max control 
level=90-95 

Come accennato in precedenza, durante la misura il feeder è controllato in modo che esso mantenga la 
densità delle particelle pari alla densità di target. La densità di target, che viene regolata dal software, è la 
Nominal covered area, cioè l’oscuramento dell’immagine con le particelle: ad esempio 1% significa che 
l’1% dell’immagine è nera e il 99% è bianca. Aumentare la Nominal covered area da 0.5% a 1% o 1.5% 
significa duplicare o triplicare la velocità di misura, ma ciò può causare un leggero aumento della 
sovrapposizione delle particelle, cioè alcune particelle (soprattutto quelle più fini) potrebbero unirsi 
provocando una stima errata della loro dimensione (in quanto lo strumento vede due particelle unite come 
l’immagine di una singola particella più grande). 

Se si prova a misurare lo stesso campione con diversi valori della Nominal covered area e i risultati 
sono gli stessi o comunque accettabili, si può usare l’oscuramento più alto dell’immagine nel metodo e 
salvarla nel task file. Valori ottimali della Nominal covered area sono: 

-0.5% per misure di riferimento molto importanti; 
-1% valore medio, che fitta per gran parte dei prodotti; 
-1.5% per una velocità più alta di misura con un leggero aumento della sovrapposizione delle 

particelle. 
Il Base of control è il valore relativo alla velocità di regolazione, si riferisce al numero di immagini 

dopo le quali il software fa l’update (cioè l’aggiornamento) della velocità per mantenere costante la densità 
di target. Il valore 20 è un valore ottimale per gran parte delle misure, soltanto se si vede un movimento 
instabile, con una densità di target che inizia a oscillare per esempio tra 0.1 e 0.8 e non raggiunge mai il 
valore di 0.5 si può cercare di modificare il Base of control e avere un feeder più stabile. 

Generalmente ciò accade con campioni che comprendono un insieme di particelle fini e grossolane, in 
quanto, finché si osservano le particelle fini la regolazione della densità di target (0.5) è esatta, ma quando si 
incontrano le particelle grossolane l’area occupata è maggiore e quindi il computer fa uno sforzo maggiore 
per ridurre la covered area e il feeder inizia a diventare instabile. 

La Maximal covered area è un valore di soglia che deve essere impostata generalmente per campioni 
molto fini (in genere << 1 mm) che tendono ad agglomerarsi. Per esempio, se durante la misura aumenta la 
densità di target, questo può accadere o per particelle grandi oppure per materiale fine che cade 
simultaneamente agglutinandosi, e viene visto come un’unica particella grande. Per evitare che possa 
accadere ciò, generalmente attiviamo tali parametri per entrambe le telecamere usando il valore percentuale 
di 2 per ottenere buone immagini. La Maximal covered area tuttavia non è un parametro di fondamentale 
importanza. 
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3.2.2. Cameras (Measurement parameters) 
In questa finestra si stabilisce quali telecamere usare e per ognuna vengono fissati dei limiti, sia 

dimensionali che relativi a particolari parametri di forma, in modo che le particelle che si trovano al di fuori 
di questi vengono escluse cliccando su Ignore particles (fig. 19). 

Se il materiale da analizzare è molto fine (< 2mm) si può deselezionare la telecamera Basic, in quanto 
il contributo che apporterebbe non sarebbe ottimale. Ma ciò dipende dal tipo di analisi che bisogna fare. Ad 
esempio, se si vuole calcolare anche la bulk density del campione (ovvero la densità del campione totale), 
non bisogna deselezionare nessuna telecamera, in modo da non escludere alcuna particella nella misura. Se 
invece si vogliono eseguire delle buone misure sulle forme di materiali molto fini, allora è consigliabile 
disattivare la telecamera Basic. 

L’Image rate è un parametro che si utilizza per scegliere la frequenza di campionamento delle 
immagini. Esso viene generalmente impostato con un valore di 1:1, il che implica che vengono considerate 
tutte le particelle. Se vengono misurate particelle più piccole, l’Image rate nella finestra di misura deve 
essere abbassato rispetto al valore ottimale di 25/s. In questo caso il flusso di materiale deve essere ridotto, 
abbassando la velocità del feeder e/o abbassando l’Image rate a 1:2. Questo perché, nel caso di molte 
particelle fini, la velocità del processore del computer non è abbastanza veloce da misurare migliaia di 
particelle in ogni immagine. Se usiamo il valore 1:1 si hanno troppe particelle in ogni immagine, per cui il 
computer non riesce a processare tutte le particelle della prima immagine e passa direttamente alla seconda 
perdendo tutte le informazioni della prima, che si traduce nel perdere gran parte delle particelle fini (cioè 
immagini piene di particelle). Quindi sarebbe meglio usare il valore 1:2, in quanto considera soltanto ogni 
seconda immagine e si perde metà del campione, ma in modo sistematico durante la misura.  

Il valore relativo al Display interval serve a impostare la frequenza dell’updating del grafico e delle 
immagini durante la misura, cioè il valore indica dopo quante immagini viene aggiornato il grafico. 
Generalmente si usano valori variabili da 20 a 50. 

Le voci number of images e number of empty images definiscono le condizioni per la fine della 
misura, cioè a dire il valore inserito stabilisce rispettivamente dopo quante immagini registrate o dopo quante 
immagini a vuoto (cioè nel caso in cui non cadano più particelle) la misura viene interrotta.  

Quando si raggiungono tali condizioni, infatti, appare una finestra che chiede se continuare o no la 
misura. Se queste condizioni non vengono raggiunte, la misura può essere interrotta manualmente cliccando 
Stop sulla barra d’applicazione in alto a sinistra nella finestra del grafico. 

La voce Fill transparent particles deve essere attivata quando si stanno misurando particelle 
trasparenti. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 19.  Finestra di dialogo Measurement conditions → Cameras (Measurement parameters). 
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3.2.3. Save image 
In questa sottocategoria è possibile attivare il salvataggio delle immagini registrate dalle telecamere 

CCD-Basic e CCD-Zoom (fig. 20). 
Cliccando su OK, le immagini vengono automaticamente salvate nella cartella del relativo task file in 

una sottocartella chiamata images. Singole immagini possono essere salvate anche durante la fase di misura, 
aprendo la finestra live image e cliccando sul simbolo Save image durante la misura. 

Questa funzione però richiede molto spazio nella memoria dell’hard disk, infatti ogni immagine 
occupa circa 735 KB, pertanto quando si esaurisce la capacità di immagazzinamento nel pc, le successive 
misurazioni non vengono salvate.  

 È possibile impostare delle condizioni per ridurre il numero di immagini salvate ed evitare il 
salvataggio di immagini vuote impostando uno o più di uno dei seguenti parametri: 

1) N: definisce quali immagini si desidera salvare. Per esempio, se N è pari a 4, il salvataggio avviene 
ogni 4 immagini. 

2) Minimum covered area [%]: definisce la covered area minima, cioè l’oscurazione di quelle 
immagini che verranno salvate, evitando così il salvataggio di immagini vuote. 

3) Save only, if at least 1 particle located in the image: quando è attivata tale casella, le immagini 
senza particelle non vengono salvate. Affinché l’immagine sia salvata, quindi, almeno una particella deve 
essere completamente presente nell’immagine. 

 
 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 20.  Finestra di dialogo Measurement conditions → Save Images. 
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3.2.4. Settings 
 

Il quadro Settings permette di scegliere tutti i parametri di forma e granulometria che sui desidera 
misurare e i modelli sulla base dei quali essi vengono calcolati (vedi paragrafo 2.2. e 2.4) (fig. 21). 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

Figura 21.  Finestra di dialogo Measurement conditions → Settings. 
 

 
Nel riquadro Particle Model si definisce il modello della particella. Il software prevede fino a 5 

modelli matematici, in base ai quali il calcolo della dimensione “x” viene effettuato relativamente a diversi 
parametri, identificati da numeri tra 1 e 5. Ad ogni modello corrisponde una diversa distribuzione 
volumetrica (Q3 distribution). Ogni modello permette di misurare diverse proprietà della particella, e la 
scelta dipende dalle applicazioni. 

Generalmente è consigliabile usare 3 modelli, ovvero xc_min, x_area, xFe_max e settare su none gli 
altri due. 

Quando si sceglie l’opzione x_area il software determina, dalla proiezione delle particelle, un 
diametro equivalente di un cerchio avente la stessa area.  

Se si sceglie xc_min i risultati sono equivalenti ai risultati delle analisi granulometriche con i setacci. 
Se si sceglie xFe_max, le particelle sono classificate in base alle loro dimensioni massime. 
I dati relativi ad ogni singolo modello vengono salvati in diversi Raw Data Files(.rdf) nella cartella 

CAMDAT del file di misura con la seguente struttura del nome del file: <nome>_modelloparticella.rdf. 
per esempio: 
 
Camsizer\CAMDAT\ cenere_xc_min.rdf. 
 

Dopo la misura, il modello della particella “numero 1” viene visualizzato nella finestra del grafico. I 
risultati degli altri modelli possono essere visualizzati leggendo i relativi Raw Data Files presenti nella 
cartella. 

La voce Size-classes for measurement serve a selezionare il file in cui sono state definite le classi 
granulometriche.  

Nel riquadro Shape Characteristics vengono scelte le caratteristiche di forma da determinare durante 
la misura. La voce Based on Volume (Q3) si riferisce alla rappresentazione dei dati secondo i volumi delle 
particelle, mentre Based on Number (Qo) è relativa a una rappresentazione secondo il numero di particelle. 
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Verranno registrate nei Raw Data Files soltanto quelle caratteristiche di forma definite in questa 
finestra prima della misura.  
 
3.2.4.1 SPHT fitting  

L’SPHT fitting è un parametro che serve a correggere la deviazione dalla sfericità tra le misure 
effettuate con le due telecamere, in quanto una stessa particella viene misurata con una risoluzione di pixel 
diversi per le due telecamere (fig. 22).  

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 22.  a) Differenza di risoluzione per le telecamere Basic (CCD-B) e Zoom (CCD-Z); b) Finestra di 
dialogo per la correzione SPHT in cui vengono sovrapposte le curve relative alle due telecamere. 

 
 

Per aumentare ulteriormente la risoluzione della camera Zoom (che è la massima) si effettua tale 
correzione seguendo questa procedura: 

- si prende il campione da misurare, cliccare su Extras →Measure for SPHT correction; 
- si apre la finestra Start Measurement, si compilano i campi desiderati con le informazioni relative 

alla misura test, si clicca su OK e si inserisce il campione per fare iniziare la misura. In questo modo il 
software effettua la misura automaticamente, creando due raw data files separati sia per la telecamera Zoom 
che per la telecamera Basic; 

- cliccando su Compute, i due raw data files misurati per le due telecamere possono essere letti in una 
finestra di dialogo. A questo punto si apre una finestra in cui è possibile fare il fitting delle due curve 
visualizzate, relative alle misure effettuate con le due telecamere, che hanno un intervallo di sovrapposizione. 
Ammettiamo, ad esempio, che la sovrapposizione sia in un intervallo compreso tra 0.625 e 1.25. Bisogna 
muovere la curva relativa alla telecamera Basic in modo da cercare di sovrapporla alla curva della telecamera 
Zoom nell’intervallo di sovrapposizione delle due telecamere; 

- nella barra che appare abbiamo valori di sovrapposizione che vanno da 0 a 3, a seconda della forma 
delle particelle. Il valore da considerare è il numero inferiore dell’intervallo di sovrapposizione (0.625 
nell’esempio). Il valore corrispondente a 0.625 nell’asse delle ordinate è il valore di SPHT ottimale da 
inserire nel task file per avere una misura corretta del campione.  
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3.2.5. Warnings 
Questa finestra permette di attivare degli avvertimenti se vengono superate alcune soglie o limiti che 

possono essere impostati dall’utente (fig. 23a). 
 
 
 

 
Figura 23.  a) Finestra di dialogo Measurement conditions → Warnings; 

b) Finestra relativa al tasto Segregation. 
 

 
 

Raw data limits 
Impostare dei limiti basati sul volume per le distribuzioni cumulative.  
Nelle caselle relative a Display è possibile decidere di visualizzare l’allarme nello schermo e/o nel 

report (fig. 23a). 
 
Q3, Q0 - limits (cumulative distribution) 
Un avvertimento viene visualizzato se i valori misurati di Q3, Q0 eccedono o vanno sotto un file di 

riferimento selezionato (“Upper reference file / Lower reference file”). Questo file di riferimento può 
essere selezionato cliccando sulla casella combo, ma anche se l’avvertimento appare sullo schermo, nel 
report o nel file da esportare. L’avvertimento appare anche quando il raw data file è caricato selezionando 
l’opzione File → Open measurement file. Se i risultati vengono esportati in formato EXCEL gli 
avvertimenti vengono scritti nell’intestazione del file.  

Nota: Per attivare gli avvertimenti deve essere creato un file di riferimento cliccando su "Options" - 
"Input reference distribution...". 

 
p0, p3 – limits (fractions) 
Un avvertimento viene visualizzato se i dati di riferimento p0, p3 vengono infranti. Bisogna 

selezionare il file di riferimento nella rispettiva casella. Anche in questo caso bisogna scegliere se 
visualizzare gli avvertimenti sullo schermo, nel report o nel file. 

 
Warning if image rate factor <: viene visualizzato un avvertimento se il numero di immagini 

registrate per secondo è minore di una certa percentuale di un possibile image rate massimo. Una soglia 
tipica di avvertimento è il 95%. 

a 

b 
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Se l’image rate è troppo basso i risultati della misura potrebbero essere sbagliati. Un basso image rate 
potrebbe essere causato da uno dei seguenti motivi: 

- troppe particelle fini con alta covered area (il che significa un’acquisizione troppo veloce); 
- diminuzione della capacità del processore a causa di altri software attivi sul PC - Diminuzione della 

capacità del processore a causa di altri fattori quali caricamento dati, visualizzazione di grafici o movimenti 
troppo frequenti con il mouse. 

 
Segregation 
Alcuni materiali hanno proprietà che potrebbero causare agglomerazione del campione. L’utente può 

selezionare delle caratteristiche e impostare dei limiti di tolleranza. Se questi vengono superati, allora si 
attiva il Segregation warning (fig. 23b). Questa opzione è usata solo in rari casi. 

 
 
3.3 Parametri della finestra “Parameters for display” 

La seconda finestra Parameters for display contiene le seguenti sottocategorie (fig. 24): 
Size classes 
Volume classes Q(V) 
Shape characteristic classes 
Table 
Characteristics 
Graph 
Graph, shape characteristics 
Save task file 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 24.  Finestra di dialogo Parameters for display → Size classes. 
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3.3.1. Size classes 
In questa finestra vengono definite le classi granulometriche con cui la misura viene rappresentata nei 

diagrammi (fig. 24).  
Per definire le classi granulometriche è possibile i) leggere un file (Read classes), ii) inserire i valori 

manualmente (cliccando su Edit), oppure iii) inserire i valori Xmin e Xmax di un intervallo.  È possibile 
immettere fino a un massimo di 50 classi granulometriche. 

Se i valori vengono introdotti in una delle finestre di Edit, deve essere cliccato il tasto Update, in 
modo da aggiornare tutte le finestre. Il limite inferiore della classe più piccola è mostrato in una finestra 
separata in quanto il numero dei limiti è maggiore di una unità rispetto al numero delle classi.  

Durante la digitazione, il numero delle classi deve eguagliare il valore della finestra Upper limits of 
all classes, altrimenti appare una finestra di errore. Durante l’aggiornamento (tasto Update), i limiti delle 
classi sono selezionati in base alla taglia e ogni limite multiplo viene eliminato. 

Per salvare le classi granulometriche deve essere cliccato il Save button e deve essere inserito un 
nuovo nome del size class file (.gkl). 

Cliccare su OK per confermare i dati impostati. 
Le classi granulometriche appena descritte sono le uniche che vengono usate per le nostre 

applicazioni, nonostante il software preveda anche la visualizzazione di classi di volume e forme, richiamate 
nei sottoparagrafi successivi, di cui si omette una descrizione dettagliata. 
 

 
3.3.2. Volume classes Q(V) 

Le classi di volume vengono usate per rappresentare i risultati in base al volume V invece che 
relativamente alla dimensione x (fig. 25). L’unità di misura in questo caso è il mm3. 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 25.  Finestra di dialogo Parameters for display → Volume classes Q(V). 
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3.3.3. Shape characteristic classes 
In questa finestra, possono essere definite o impostate le classi per la visualizzazione delle 

caratteristiche di forma in base ai parametri di forma disponibili nel software (fig. 26).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 26.  Finestra di dialogo Parameters for display → Shape charachteristic classes. 

 
 
 
3.3.4. Table 

In questa finestra vengono settati i parametri che si desidera visualizzare all’interno della tabella 
riassuntiva alla fine della misura (fig. 27). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 27.  Finestra di dialogo Parameters for display → Table. 
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La tabella presente in tale finestra è formata da 8 colonne. Se si sceglie di configurare più colonne, in 
tale finestra vengono omesse le colonne di destra, ma tutte le colonne configurate vengono considerate 
durante l’esportazione dei dati.  

La prima e seconda colonna contengono sempre i limiti della classe granulometrica.  
Dalla barra di controllo di tale finestra, cliccando su View → Characteristics vengono scelti i diversi 

parametri sia di taglia che di forma che si vogliono visualizzare. 
Cliccando su Edit → Copy è possibile copiare il file in un documento tipo Word o Excel (ctrl+v). 

 
 
3.3.5. Characteristics 

In tale finestra vengono visualizzate le caratteristiche della distribuzione granulometrica e della 
sfericità misurate dal CAMSIZER. Può essere attivata soltanto a misura ultimata cliccando su View → 
Characteristics (fig. 28). 

Anche in questo caso, cliccando su Edit → Copy si può copiare la finestra visualizzata in un 
documento di testo. 

 

 
Figura 28,  Finestra di dialogo Parameters for display → Characteristics. 
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3.3.6. Graph 
 

In questa finestra vengono settate le caratteristiche del grafico finale (fig. 29).  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 29.  a) Finestra di dialogo Parameters for display → Graph;  
b) Sottofinestra relativa al menu View → Characteristics. 

 
 
L’andamento grafico può essere visualizzato come istogramma, come curva cumulativa, come inverso 

della cumulativa o come gaussiana. Inoltre può essere scelta l’unità di misura degli assi cartesiani cliccando 
su View → Characteristics (fig. 29b). 

Cliccando su Extras è possibile impostare alcune caratteristiche come il colore del grafico, il tipo di 
griglia, la legenda ecc. 

  Se si clicca su File - Read Comparison File è possibile aprire fino a un massimo di 10 files diversi di 
paragone all’interno dello stesso grafico. 
 
 
3.3.7. Graph, shape characteristics 

In questa finestra è possibile analizzare le caratteristiche di forma misurate sottoforma di grafico.  
Anche in questo caso può essere scelta l’unità di misura degli assi cartesiani cliccando su View → 

characteristics (fig. 30b). 
Cliccando su Extras è possibile impostare alcune caratteristiche come il colore del grafico, il tipo di 

griglia, la legenda ecc. 
Se si clicca su File → Read Comparison File è possibile aprire fino a un massimo di 10 files diversi 

di paragone all’interno dello stesso grafico (fig. 30a). 
 

a 

b 
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Figura 30.  a) Finestra di dialogo Parameters for display → Graph, shape characteristics; 
b) Sottofinestra relativa al menu View→ Characteristics. 

 
 
3.3.8. Save task file 

In questa finestra viene nominato e salvato il task file e vengono inserite tutte le informazioni 
necessarie per la caratterizzazione dello stesso, quali il tipo di materiale, la data ecc. (fig. 31). 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Figura 31.  Finestra di dialogo Parameters for display → Save task file. 

 
 
 
 

a 

b 
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4. Misura 
 

Cliccando su Measure dalla barra delle applicazioni inizia la misura (fig. 32). 
 

 
Figura 32.  Barra delle applicazioni del software del CAMSIZER. 

 
 

Durante la misura viene visualizzato l’andamento grafico nella finestra di misura (fig. 33). La misura 
può essere interrotta ogni qualvolta lo si desidera premendo Stop (cerchio rosso in fig. 33). In base ai 
parametri settati nel task file, dopo un totale di immagini non visualizzate, cioè in un intervallo in cui lo 
strumento non misura particelle, appare una finestra di dialogo in cui viene chiesto se continuare o no la 
misura. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figura 33.  Barra delle applicazioni del software del CAMSIZER. 
 

 
 

Nella finestra di misura in basso appaiono diversi parametri. 
Il parametro ur posto in basso a sinistra (cerchio rosso in fig. 33), indica la velocità del feeder durante 

la misura, che viene automaticamente regolata in modo da permettere un flusso costante di materiale in base 
alla pre-determinata Nominal covered area. Comunque, il valore massimo raggiungibile è tale da non 
superare mai il valore di Max control level impostato nel task file. 

Il parametro fld è il valore relativo alla densità di target, in base al quale vediamo quanto è stabile 
durante la misura, e viene visualizzato sia per la telecamera Basic che per la Zoom. 
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Il grafico viene aggiornato dopo un numero fisso di immagini CCD analizzate. Tale numero è 
rappresentato dal display interval che viene fissato nel task file (paragrafo 3.2.2) e che generalmente è 
compreso tra 20 e 50. 

Il number of images è il numero di immagini mandate al computer per il processing (cerchio rosso in 
fig. 33). 

Importante - Se qualche immagine non viene elaborata, a causa di troppe particelle oppure se 
muoviamo il mouse o facciamo altre operazioni durante la misura, questo valore diminuisce, perdendo anche 
il 20% delle immagini. Quindi si raccomanda di non muovere il mouse e le finestre durante la misura. 
Nella colonna in basso a sinistra è riportato anche il tempo di acquisizione (cerchio rosso in fig. 33).  
  
  
5. Analisi dei Risultati 
 

I risultati possono essere visualizzati cliccando su Results (fig. 32). In particolare possono essere 
visualizzati sottoforma di tabelle, grafici granulometrici, grafici di forma e caratteristiche. Inoltre è possibile 
calcolare il valore medio di più analisi, un trend temporale e un report giornaliero delle analisi effettuate. 
 
 
6. Pulizia e operazioni a fine misura 
 

Alla fine di ogni misura ricordarsi di togliere il campione analizzato dal cassetto di raccolta. 
Per pulire il CAMSIZER alla fine della misura bisogna accendere il compressore collegato allo 

strumento e azionare la leva nera posta nel retro del CAMSIZER per far circolare l’aria nella camera di 
misura. Dato però che la potenza del compressore non è sufficiente per togliere tutta la polvere presente nei 
vetri, questi ultimi devono essere prima puliti con una spazzola o un pennellino pulito e asciutto. 

Per la pulizia delle parti in contatto con il campione, come il funnel, il feeder e il vassoio di raccolta 
del campione possono essere utilizzate delle pezze asciutte o umide oppure dell’aria. 

Non usare né acqua corrente né solventi organici per pulire il CAMSIZER. 
Non toccare con le mani i vetri nella camera di misura. 
 
 

7. Calibrazione dello strumento 
 

La calibrazione del CAMSIZER viene effettuata mediante l’uso dell’apposito standard di calibrazione 
accessorio. Questo è rappresentato da un vetrino trasparente in cui sono presenti immagini scure di cerchi di 
diverse dimensioni che coprono il range di misura dello strumento. Per effettuare la calibrazione cliccare 
sulla barra del menu (fig. 32) alla voce Extras → Calibration, e seguire le istruzioni che appaiono. La 
Retsch non indica con quale frequenza eseguire tale operazione, tuttavia suggerisce di ripeterla in media una 
volta l’anno oppure ogni volta che lo strumento viene spostato.  

 
 

8. Conclusioni e prospettive future 
 

Lo scopo principale di questo rapporto tecnico è quello di spiegare sinteticamente i principi di 
funzionamento e le potenzialità del CAMSIZER, ma anche di offrire una guida d’uso a quanti in futuro 
volessero utilizzare questo strumento. 

L’uso del CAMSIZER in ambito vulcanologico per le analisi granulometriche può offrire numerosi 
vantaggi, in primo luogo la riduzione dei tempi di misura. Prove di riproducibilità delle misure, compiute 
analizzando 10 volte lo stesso campione, hanno dimostrato che lo strumento è molto affidabile, presentando 
infatti un’estrema precisione, con differenze trascurabili tra i risultati ottenuti sullo stesso campione.  

Questo nonostante si debba tenere in considerazione il fatto che campioni sciolti di tefra sono per loro 
natura fragili, in altre parole ceneri e lapilli si potrebbero “consumare” prova dopo prova e i risultati finali 
riguardanti la distribuzione granulometrica (e quindi anche l’analisi delle forme) potrebbero variare. In 
particolare i campioni più grossolani (lapilli) potrebbero rompersi in più parti cadendo all’interno della 
camera di misura. Allo stesso modo è evidente come sia pressoché impossibile quantificare il tasso di 
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erodibilità e smussamento di un campione sottoposto ad analisi granulometrica, sia essa effettuata con una 
procedura tradizionale che con il CAMSIZER.  

In futuro verrà presentato uno studio adeguato sulla riproducibilità e affidabilità delle misure eseguite 
col CAMSIZER e un confronto tra l’analisi granulometrica eseguita con setacci e quella con il CAMSIZER, 
in modo da valutare sia le differenze delle rispettive analisi che i valori dei principali parametri 
granulometrici, come il sorting e la mediana, ottenuti con le due diverse metodologie.  

Per quanto riguarda la misura delle forme e dei relativi parametri, come abbiamo accennato in 
precedenza questo argomento dovrà essere trattato in maniera molto più approfondita rispetto alle misure 
dimensionali, in quanto al momento non esiste la possibilità di verificare l’affidabilità delle misure, così 
come è stato possibile fare per le misure granulometriche.  
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Appendice  
 
A. Parametri di input  
 

Sono stati preparati diversi campioni di lapilli e ceneri caratterizzati da differenti granulometrie (da 
fini a grossolani) ed eterogeneità con lo scopo di utilizzarli per impostare i parametri di riferimento ottimali 
del software e quindi i relativi task file.  

In pratica, dovendo analizzare un campione col CAMSIZER, è possibile scegliere il task file 
indicativo che permette di eseguire la misura nella maniera più affidabile sulla base delle indicazioni 
riportate nella tabella sottostante.  

Nella prima colonna è indicato il nome del task file corrispondente alla tipologia di campione 
utilizzato. Nelle colonne successive sono riportati rispettivamente: l’intervallo dimensionale, il tipo di feeder 
e relativo funnel da utilizzare (piccoli o grandi) e l’uso della guida accessoria per le particelle fini. 
 
 
 
 
 
 
 
 
 
 
 
 
B. Formato e directory dei files  
  

I task file sono salvati nella directory …\CAMSYS. 
I risultati di misura vengono salvati in una serie di files nella directory…\CAMDAT\-nome della 

directory. Il nome della directory è definito nel task file. 
 
Esempio: 
Directory: Sand 
Nome del file: Test 
Numero del file: 6 
Il risultato di misura è salvato nel file: 
…\CAMDAT\Sand\Test006.rdf 
Inoltre possono essere generati anche file .ccg , .xld, .xle 
In particolar modo si ha: 
CAMSYS 
Task file-----------------*.AFG (formato interno) 
Size class file-----------*.GKL (formato interno) 
Fitting file---------------*.FIT (formato interno) 
Reference file-----------*.REF (formato ASCII) 
Fraction limit files------*.RPx con x=0,2,3 
CAMDAT 
Raw data files-------------*.RDF  
File Excel------------------*.XLE (formato inglese) 
                                         *XLD (formato tedesco) 
File in formato Retsch----*.CCG 
File in formato NSP-------*.NSP 
File in formato Ratio-------*.SIG 

Task file 
suggerito 

Intervallo dimensionale 
(mm) 

Feeder e Funnel Guida accessoria 

Lapilli grossolani >16 mm Grandi No 
Lapilli 2-16 mm Grandi No 
Lapilli e cenere < 8 mm Piccoli No 
Cenere grossolana 1-2 mm Piccoli No 
Cenere media 0.125-1 mm Piccoli Si 
Cenere fine < 0.125 mm Piccoli Si 
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